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OVERVIEW

The ADIsimPE simulator is a result of Analog Devices, Inc.,
teaming with SIMPLIS Technologies. ADIsimPE allows the full
simulation of Analog Devices products in the library while still
offering the entire functionality of the SIMetrix/SIMPLIS Intro
version. In addition, ADIsimPE integrates with ADIsimPower
to quickly verify circuit performance.

ADIsimPE, which is powered by SIMetrix/SIMPLIS, is a circuit
simulation suite optimized for the design and development of
analog and mixed signal circuits. SIMetrix mode is ideal for the
simulation of general nonswitching circuits. It provides full
Pspice compatibility for use with industry-standard SPICE models.
SIMulation piecewise linear system (SIMPLIS) mode simulates
the operation of switching circuits with vastly improved robustness,
speed, and accuracy compared to standard SPICE. It is particularly
useful for switching power supply, phase-locked loops (PLLs)
and analog-to-digital converter (ADC)/digital-to-analog
converter (DAC) applications.

Additional details are available on the SIMPLIS Technologies
website.

ADIsimPE is intended for Analog Devices customers who do
not have a full license for the SIMetrix/SIMPLIS program. This
tool can simulate Analog Devices encrypted schematics as well
as nonencrypted Intro version compatible ones. The full license
SIMetrix/SIMPLIS version can simulate all encrypted schematics
from any partnered company.

ADIsimPE offers the following:

e  Full schematic capture

e  SPICE or SIMPLIS simulation mode

e  Waveform viewer and analysis

e More than 1000 IC models and application circuits to get
users started with

e  Support from the EngineerZone

4 ADISimPE
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The tool includes:

and analysis
Regulators, and more

more

ADIsimPE

Linear and Mixed-Signal Circuit Simulator - Personal Edition

ADISIimPE powered by SIMetrix/SIMPLIS is a Personal Edition circuit simulator
ideally suited to evaluate Analog Devices Linear and Mixed Signal Components.

* Extensive library of ADI IC models and applications schematics
* Full schematics capture and editing capabilities with easy waveform viewing

* SPICE mode SIMetrix simulator ideal for op-amps, references, Linear
* SIMPLIS mode simulation optimized for Switching Power supplies, PLLs, and

* Integration capability with ADIsimPower design tools

Assistance using ADIsimPE can be found via the Help menu or our EngineerZone
ower/adisimpe

Forum at: ez.analog.com/community/

Library content and instructional materials are available at: www.analog.com/

//ez analog.com/community/power/adisimpe

ry content and instructional materials are available at: www .analog.com/ADIsimPE

12382-001

Figure 1. ADIsimPE Linear and Mixed-Signal Circuit Simulator

PLEASE SEE THE LAST PAGE FOR AN IMPORTANT
WARNING AND LEGAL TERMS AND CONDITIONS.
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GETTING STARTED

Download the ADIsimPE installation file from 2.
www.analog.com/ADIsimPE.

Note that you must have a myAnalog account to download the
ADIsimPE installation file from www.analog.com/ADIsimPE.

INSTALLATION PROCEDURES

Take the following steps to install ADIsimPE on a Microsoft®
Windows®-based PC:

Click Next to accept the license agreement with I accept
the terms of the license agreement selected. The
destination directory then appears. (If you do not accept
the license agreement, you cannot proceed with the
installation of the ADIsimPE.)

ADISImPE - InstallShield Wizard [

License Agreement
Please read the following license agreement carefully. \

1. Double-click adisimpe.exe. This self extracting executable
then initiates the ADIsimPE InstallShield Wizard.

ADIsimPE - InstallShield Wizard

Preparing to Install...

-dé

ADISImMPE Setup is preparing the InstallShield Wizard, which
will guide you through the program setup process. Please
wait.

Preparing to Install...

IMPORTANT NOTICE -

e Software") that can be used by clicking "I accept the terms of the ‘il
licence agreement” at the bottom of this page is protected by copyright. The right to
license the Software to you belongs to SIMetrix Technoloegies Limited. The Software

may not be used or copied without our permission. It may only be used on the

licence terms set out below and we offer you a licence on these terms. BY USING

THE SOFTWARE YOU WILL BE DEEMED TO HAVE READ AND ACCEPTED THESE

TERMS. IF YOU DO NOT AGREE WITH THESE TERMS, YOU MUST NOT USE THE
SOFTWARE.

1. Acceptance of Terms -

(@)1 accept the tarms of the license agreament

(") Ido not accept the terms of the license agreement

[<sox [ o> ) [comes ]

12382-004

Cancel

Figure 2. Preparing to Install the ADIsimPE InstallShield Wizard

Click Next within the ADIsimPE InstallShield Wizard
dialog box (see Figure 3). 4.

12382-002

ADISimPE - InstallShield Wizard ==

Figure 4. ADIsimPE License Agreement

Select the destination location. The ADIsimPE
InstallShield Wizard default directory for ADIsimPE is
C:\Program Files (x86) and reflects the ADIsimPE version
number. (Your version number may vary from the one
depicted in Figure 5.) To change the installation directory,
click Browse.

After selecting the destination location, click Next (see
Figure 5).

ADISimPE - InstaliShield Wizard ==

‘Welcome to the ADISImPE setup Wizard Choose Destination Location
Select folder where setup will install files.

This Wizard will install ADIsimPE on your computer. To
continue, click Next.

Figure 3. ADIsimPE InstallShield Wizard Setup

12382-003

Please enter the location where you would like to install the program. You may type a
new folder name or click the Browse button to find a new location.

C:\Program Files (x86)\ADIsimPE_800Y

[ < Back ][ Next > ][ Cancel

12382-005

The license agreement then appears (see Figure 4).

Figure 5. Choose Destination Location Screen

The Ready to Install the Program screen then appears (see
Figure 6).
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5. Click Install to begin the installation, Cancel to quit, or ADISImPE - InstallShield Wizard ==
Back to make installation changes (see Figure 6). Setup Status “
ADIsimPE - InstallShield Wizard == \‘

Ready to Install the Program ADISImPE is configuring your new software installation.
The wizard is ready to begin installation.

Click Install to begin the installation.

C:\...\Module_1_Bxamples\Modeling Blocks\CCM_Modulator.sxcmp

If you want to review or change any of your installation settings, click Back. Click Cancel to
exit the wizard.

I 1Shiald

Cancel

e Figure 7. Setup Status of the Installation of Files
[ < Back ][ Install ] [ Cancel

12382-007
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7. Once the ADIsimPE InstallShield Wizard has installed its
Figure 6. Ready to Install the Program files and configured itself in the Windows registry, the
InstallShield Wizard Complete dialog box appears (see
Figure 8). Click Finish to close the dialog box (see Figure 8).

6. The ADIsimPE InstallShield Wizard provides a status of
the installation of files and approximately where it is in
process (see Figure 7). If you click Cancel at this point, you ADISimPE - InstallShield Wizard
will interrupt the installation of files and be left with an
incomplete ADIsimPE installation that may not work. (Use
the Cancel button if the ADIsimPE InstallShield Wizard
is idle many minutes and does not progress.)

InstallShield Wizard Complete

Setup has finished installing ADISImMPE on your computer.

< Back Cancel

Figure 8. Installation Finished

12382-008

Once installation is completed, it is recommended that users see
the Updating ADIsimPE section to avoid future licensing issues.
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HOW TO USE THE SOFTWARE

To open the software, take the following steps:

1.
2.

Click the Start menu.

Select All Programs/ADIsimPE 8.00, where 8.00 indicates

your version number, which may vary (see Figure 9).

L Y-
‘Ep Software Center
SIMetrix-SIMPLIS 8.00 »
7
VEE| Excel 2013 b

Lync 2013

PowerPoint 2013 »

ko

<) QCAD »

O

—

LT

& Motepad++

~

/ :'. 11 »
[ Internet Explorer

ADIsimPE 8.00
7

Q&

6“ Snipping Tool
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Figure 9. Choose ADIsimPE

The screen in Figure 10 then appears with the option of
migrating your old configuration to the new version (if
applicable) and the option to add example files.

4 Starting ADIsimPE 8.00i for the First Time  [wem]

Preferences from earlier version

Would you like to migrate the configuration
from your earlier version of ADISimPE? _
@) Yes
Most configuration settings will be copied
including installed models and symbols along
with preference settings. A log file showing
what is copied will be created during this () Mo

process

The example files are from the Analog Devices library,
which includes all Analog Devices encrypted schematics and
models from op amps to switching regulators, as well as a
good selection of application circuits to get started with
(see the Library of Analog Devices Schematics section).

3. After making the selections, click Close. The splash screen
shown in Figure 11 then appears.

J ADIsimPE =]

oevces  ADIsimPE

AHEAD OF WHAT'S POSSIBLE™

Linear and Mixed-Signal Circuit Simulator - Personal Edition

ADISImPE powered by SIMetrix/SIMPLIS is a Personal Edition circuit simulator
ideally suited to evaluate Analog Devices Linear and Mixed Signal Components.

The tool includes:

* Extensive library of ADIIC models and applications schematics

* Full schematics capture and editing capabilities with easy waveform viewing
and analysis

* SPICE mode SIMetrix simulator ideal for op-amps, references, Linear
Regulators, and more

* SIMPLIS mode simulation optimized for Switching Power supplies, PLLs, and
more

* Integration capability with ADIsimPower design tools

Assistance using ADISImPE can be found via the Help menu or our EngineerZone
Forum at: ez.analog.com/community/power/adisimpe

Library content and instructional materials are available at: v

analog.com/

12382-011

Figure 11. ADIsimPE Splash Screen

4. Click Ok. The command shell opens (see Figure 12 to
Figure 14).

When ADIsimPE is started from the Windows Start button,
users can open a new (blank) schematic or an existing schematic
using the options found under the File pull-down menu in the
Command Shell (see Figure 12). These options then open the
Schematic window (see Figure 14).

Note that the default simulator is SIMetrix, and parts available
vary depending on which default simulator is chosen.

Figure 10. Starting ADIsimPE 8.00i for the First Time Screen

12382-010
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oevices  ADISImPE

AHEAD OF WHAT'S PO

Recent Schematics ADIsimPE
[4] ADP1741 PSRR vs Headroom 1.3Vout 100mA.sxsch @ Example Circuits

'_d ADP1741 1.75Vin 0.75Vout PSRR vs Iout 1Vheadroom.sxscl Analog Devices Home Page

e

¥ Open.. (5] Amplifier and Linear Design Tools
@ SPICE Models for Download
(5]

ADIsimPE Home Page

Create New
|Z| Schematic

'_d Symbol

Putting the Future First
Analog Devices is proud to support
FIRST® Robotics Competition.
Learn More

Default Simulator
@ SIMetrix
(© SIMPLIS

Figure 12. ADIsimPE Command Shell Window

oevices  ADIsimPE

AHEAD OF WHAT'S POSSIBLE™

Recent Schematics ADIsimPE
'_d ADP1741 PSRR vs Headroom 1.3Vout 100mA.sxsch (5] Example Circuits

[4] ADP1741 1.75Vin 0.75Vout PSRR vs lout 1Vheadroom.sxsch| @ Analog Devices Home Page

k¥ Open.. (5] Amplifier and Linear Design Tools
@ SPICE Models for Download

@ ADIsimPE Home Page

Create New
|Z| Schematic

._d Symbol

Putting the Future First
Analog Devices is proud to support
FIRST® Robotics Competition.
Learn More

Default Simulator
@ SIMetrix
(© SIMPLIS

Figure 13. ADIsimPE Open New Schematic Window
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4 ADBImPE Main Window
Eie Edit View Simulator Place Prope Probe AC/Noise Hierarchy Monte Carlo  Tools Help

File View untithed
Add Dirsctory [

Examples-50
Open Example Schematic..

Part Selector | Command Shell | File View

AP

Q& ADIsimPE

bty

o [

Wiah View | || Schematic Fdtor |7

>

12382-014

Figure 14. ADIsimPE Schematic Window
UPDATING ADIsimPE LIBRARY OF ANALOG DEVICES SCHEMATICS

The library of schematics continues to grow, particularly as new
devices become available. Click Help in the ADIsimPE Command
Shell window and check off the Check Updates Now box to check
for updates regularly (see Figure 15). Analog Devices recommends
checking updates monthly.

2 Update Settings @

Check Updates Now

Automatic Update Schedule |Monthly -

o ) cwen ]

12382-015

Figure 15. Update Settings

The Check Updates Now feature periodically checks (via the
Internet) if there is a new release of ADIsimPE. New releases
may contain updated model library content from Analog
Devices and/or enhanced features for the application.

If users opt to have examples files installed, these files are in a
directory named in a manner that reflects its software version,
such as: C:\My Documents\ADIsimPE\Examples-80.

This installation directory has two subdirectories, one for
SIMetrix schematics and another for SIMPLIS schematics.

The schematics encrypted with Analog Devices products are in
respectively named subdirectories:

¢  C:\My Documents\ADIsimPE\Examples-80\SIMetrix\
Analog Devices\

e  C:\My Documents\ADIsimPE\Examples-80\SIMPLIS\
Analog Devices\

The schematics for general SPICE applications and linear
circuits are in the SIMetrix subdirectory. The models for
nonlinear and switching circuits are in the SIMPLIS
subdirectory.

Many of the SIMPLIS schematics from Analog Devices for
switching regulators are also available within their respective
ADIsimPower design tools (such as, Microsoft Excel). When
the schematic is exported from an ADIsimPower design tool,
ADIsimPE also obtains settings such as Vin, Vour, lour, as well
as component selection from the current design in the tool.

For more information about the integration between
ADIsimPower and ADIsimPE, see the Quick Start Steps for
Running Power Simulations section.
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LIBRARY OF ANALOG DEVICES MODELS

Encrypted models of Analog Devices parts are available from
within the ADIsimPE tool. Because the models are encrypted,
they do not count toward the ADIsimPE limitations imposed
upon schematic size for simulation.

Before inserting a model into a schematic, ensure that
ADIsimPE is in the proper simulation mode because the
available models are dependent upon which mode is used. To
change the simulation mode in the Schematics Edit window,
select Simulator/Switch to SIMPLIS Mode or Simulator/Switch
to SIMetrix Mode. The resulting dialog box has radio buttons to
choose either SIMetrix for linear applications or SIMPLIS for
nonlinear or power switching applications (see Figure 16).

Choose Analysis... F&
Bun Schematic F9
Check

Resume

Restart Transient...
Pause

Abort
Convergence Options...
Manage Data Groups...

View/Edit Netlist

Open List File

Import Models...

Open/Close Command (F11) Window F11
Create Netlist as Subcircuit...

Create Netlist as SPICE 2 Subcircuit...

Show Statistics

12382-016

Switch to SIMPLIS Mode

Figure 16. Select Simulator

Examples-80

Select by Specification v
Open Example Schematic

Other Components
Special Linear Functions
Switches

Voltage References

Search Part..
Hierarchy v
Create Model v

Magnetics
Passives
Copnectors
Probe
Voltage Sources
Current Sources
Controjled Sources
Bias Annotation
Semigonductors
Digital
Digital Generit
Analog Behaviowral
Analog Functions
Part Saiector | Command shall __ 0TS t

ADISMPE

D&% ADISimPE

Welcome ts ADISMFE | unlitled

Differential Amplifier
Fully Differential Amplifier
Instrumentation Amplifier
Operational Amplifies

ADIsimPE makes the following distinction between symbols
and models:

e A symbol is what is graphically depicted within the
schematic and shows how the circuit element connects
with other elements.

e A model is a netlist description of the circuit element. The
same schematic symbol may be used for many different
models (or parts). The properties on a symbol specify
which model is used for simulation. Inserting a symbol
does not guarantee that it has an underlying model or the
desired model.

To insert an existing model into your schematic, select from the
Place pull-down menu and click From Analog Devices Library.

e When in SIMetrix mode, the submenu from the pull-down
shows Amplifiers, Switches, and various other
components (see Figure 17).

e When in SIMPLIS mode, the submenu from the pull-down
shows Switching Regulators and other components.

Use the Schematic Editor to insert any number of devices (see
Figure 17).

+ ADSImPE Main Windaow —
Eile Edit View Simujstor [Place| Prope Probe AC/Noise Hierarchy MonteCario Tools Help Web View = Schematic Edéoe =
X nd e Repieal Last Place. Ak |G Il K~ + O EE L EIEELTDE # N &
R ) From Model Library.. G x|
ndd Direciory From Symbol Library..
From Analog Devices Library » Amplifiers Current Sense Amgplifier

12382-017

SMetrix

Figure 17. Analog Devices Library
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Deleting and re-placing the devices may resobve the problemn

Mote: You can set the 'SIMULATOR' symbol property
to declare which sirmulators are supported by a device

However, the type of simulation (SIMetrix or SIMPLIS)

restricts which models can be in the circuit for simulation.
Incompatible models will highlight in a different color (see
Figure 18).

& The highlighted components may not function in Shetrix mode

Figure 18. Error Message when Mixing Models

In addition, the Part Selector tab, shown under the toolbars in

12382-018

Figure 19, is a useful way to locate models for insertion into
schematics without having to go into the Place/Select Device
pull-down menu (see Figure 20).

4 ADISiePE Main Wirsdine

Ble  Edt View Serulitor Plsce  Prohe  Probe AC/Noie  Hyemchy  Bante Cadlo  Tooks

"EXH e IC PEACEKHEAQAQ /P B ( F~+ FEXFO

| part salecter
Symmbali

Analag Furctions
Digital Functions

SysternDesigner Functions (e 12 bit)
MOSFET Dvivens

Beraser Supgily Controlless

Diseretes

Magretics

Passives

Connectars

Frobes

Veltage Sourees

Cusrert Sources

Unkrigwn

Controlled Sources

AMPLIS PWL Devices

Workthasts

Cibsalete

Analog Devic

Enginearions Support Community

Povrered bry SiMetiixfSMPLIS

S X1

untitled

Help

[E=3 o ==

| Wit Ve || | Schissmatic Edtor

x|

Winkcorms to ADIGTPE | uriitled

12382-119

Figure 19. Part Selector Tab
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# Select Device

* Recently Added Models * ~ || 4016 ADG441B ADG609 ADGS19  MAX4890
* All User Models * ||| 2086 ADG441BS ADG611 ADG820  MAX4891
* All Models * ADG1211 ADG4415 ADG612 ADGE21  MAX4892
Analog switches ADG1212 ADG441T ADG613 ADG822
BIT - Dual = || ADG1213 ADG441TS ADG658 ADGS823
BIT - Multiple ADG1236 ADG442  ADG659 ADG839
Bridge Rectifiers ADG1311 ADG4428 ADG6E61 ADG841
Buffers | |ADG1212 ADG442BS ADGA62 ADG842
Comparators ADG1313 ADG4425 ADGE63 ADG849
Counters ADG406 ADG444 ADG701 ADGS59
Current Mirrors ADG406B ADG4448 ADG702 ADGS34
Current Monitors ADG407 ADG444BS ADG711 CLC532
Current Sense Amplifiers ADG407B ADG444S ADG712 HC4018
Differential Amplifiers ADG408 ADGS08F ADGT13 HC4051
Digital Arithmetic ADG408B ADG508FB ADGT19 HC4052
Digital Buffers ADG408T ADG508FT ADGT721 HC4053
Digital Functions ADG409 ADG509F ADGT722 HC4066
Digital Multiplexers/Demultiplexer ADG409B ADG509FE ADG723 HC4067
Digital/Analog interfaces ADG409T ADG509FT ADGT741 HC4316
Diode ADG411 ADG511_3 ADGT742 HC4351
Drivers ADG411B ADG511_5 ADGT49 HC4352
Dual Diodes - | |ADG411T ADG512_3 ADG779 MAX4601
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—— ADG412B ADG513_3 ADGT782 MAX4603
11;1 S ADG412T ADG513_5 ADGT783 MAX4684
..... VOO . | A ADG413 ADGS528F ADGT787 MAX4685
SRR ADG413B ADG528FE ADG801 MAX4714
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Filter * l Flace ] i Cancel ] i Help

C:\Program Files (x86)\ADISImPE_800\support\Models\analog.|b

Figure 20. Select Model
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QUICK START STEPS FOR RUNNING SIMULATIONS

ADIsimPE features SIMetrix and SIMPLIS tutorials. Go to the
Command Shell window Help menu to find these (see Figure 21).

SIMetrix Documentation
SIMPLIS Documentation

SIMetrix Tutorials
SIMPLIS Tutaorial

Schematic Editor
Select Help Source...

PDF Manuals »
Check for Updates...
Unlock Features...

12382-020

About..
Figure 21. SIMetrix Tutorials or SIMPLIS Tutorials

Another excellent path for understanding how to work with
ADIsimPE is to explore the examples. The examples, if installed,
are typically found in the Command Shell window by selecting
File/Open Schematic or in the Schematic window by clicking
File/Open (see Figure 22). The default location is the directory
where the examples are installed.

4 oo ==

K b = e v AMIR v igakagh » My Doxuments » ADISmPL » Lxamgies-B0 ¢

= |sermmane pom Cosen nn

Oaen

12382-021

Figure 22. SIMetrix or SIMPLIS Examples

QUICK START STEPS FOR RUNNING POWER
SIMULATIONS

Analog Devices power management incorporates the simulation
abilities of the ADIsimPE tool into its recommended development
process. To design power circuits, take the following steps:

1. Select the part and the design tool.
2. Design and optimization.
3. Simulate.

After entering the design criteria into ADIsimPower for Step 1,
ADIsimPower recommends appropriate parts and topologies:
www.analog.com/adisimpower.

ADIsimPower lets users download the appropriate design tools
for the selected devices. Note that these tools are Microsoft
Excel based.

When users run the respective ADIsimPower design tool on
their local PC during Step 2 with their design criteria and
settings for the features of the device, the tool produces a
schematic and bill of materials for their design that they can
further optimize.

Once Step 2 results in an optimized design, some ADIsimPower
tools assist users with simulating (Step 3) by having a SIMPLIS
schematic embedded in the tool for export. All settings relevant
to their design and their desired simulation are exported to
ADIsimPE with the model.

When the ADIsimPE simulator is launched from a design tool,
it can immediately simulate users’ designs by pressing F9.

Therefore, the recommended way of running SIMPLIS
simulations on Analog Devices power devices is from their
respective design tools because users can then inherit simulation
values for the following:

e Vi, Vour, and Iour operating conditions.

e All bill of material components needed for their designs.

e  All advanced settings and jumpers.

e  The settings of the desired simulation such as start, stop,
and number of data points.

To specify the desired simulation, click Simulate with
ADIsimPE/Simplis from the design tool (see Figure 23).

Simulate with
ADIsimPE/Simplis

Figure 23. Button in ADIsimPower (Excel Tool): Simulate with
ADIsimPE/Simplis

12382-022

The export process of the design tool will then access the
appropriate embedded SIMPLIS model and change the settings
based on the current design state and desired simulation. The
export process will prompt for an appropriate directory and
name for the exported file.
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The default export directory is the location of the Excel design
tool when it was started. If the design tool is started from within
a ZIP file, the export directory must be changed. The export
process cannot write into a ZIP file.

The default filename for export is the name of the embedded
SIMPLIS model. Renaming of the export file is recommended
to avoid confusion because settings internal to the file will
change based on the current state of the design tool and the
desired simulation. If a file in the export directory already has
the desired name, the user is prompted to overwrite the existing
file or cancel the export operation.

The Export Simplis Model and Export & Run Simplis Model
buttons both save a SIMPLIS file for the user to access (see
Figure 24). Clicking Export & Run Simplis Model performs
the additional step of starting ADIsimPE (or SIMPLIS) with
the exported file. However, the Export & Run Simplis Model
button disables if the design tool does not detect a computer
registry entry for ADIsimPE (or SIMPLIS).

Simulation Options

The simulation options shown depend on the design tool and
the recommended solution from the design tool. Some design
tools may restrict which simulation options are available. If the
solution only has one rail, the Rail to Simulate option will not
be present. In meeting customer design criteria to recommend
a solution, the design tool may recommend solutions for which
it does not have a SIMPLIS model. In these cases, the Export
Simplis Model and Export & Run Simplis Model buttons
disable.

Qutput Simplis/Simetrix Model

ANALOG
DEVICES

Desired Simulation

@ :Bode + Load Transient + Ripple:

" Bode (only)

" Load Transient (onfy)
" Current Limit + Restart
(" Start Up + UVLO

" Shutdown + UVLO

Export & Run Simplis Model

—
—

Export Simplis Model (only) | Reset Defaults Cancel

Note: At Full Load Current

@ Vin Minimum

" Vin Maximum
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Figure 24. Exporting from Analog Devices Design Tools
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Figure 25. Example Schematic Exported from a Design Tool into ADIsimPE

It is not possible to import the settings from an exported
ADIsimPE (SIMPLIS) file back into an ADIsimPower design tool.

ADIsimPE permits adjustments to the simulation, generates
results, and explores the full capabilities of the SIMPLIS engine.

The benefits of using ADIsimPE (or the full SIMetrix/SIMPLIS
version) go beyond the simulation/validation of the power
management portion of a design. Users can add to the schematic
load circuitry and other parts of their applications and simulate
how this will work. Whereas the Analog Devices models are
encrypted to protect Analog Devices’ intellectual property (IP),
ADIsimPE allows the simulation of much larger circuits than
would otherwise be permitted with the free SIMPLIS distribution.

SIMetrix/SIMPLIS is a feature rich software application even
when distributed as ADIsimPE. Its description and operation
are beyond the scope of this document. For more information,
refer to SIMPLIS Technologies documentation.

RUNNING SIMULATIONS FROM ANALOG DEVICES
POWER MANAGEMENT SCHEMATICS

Assuming that the ADIsimPower design tool produced a valid
design, when the SIMPLIS schematic is exported, it is ready for
simulation within ADIsimPE. To run a simulation, select
Simulator/Run (or press F9).

Users can place additional probes within the schematic for
observation.
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FEATURES OF ANALOG DEVICES POWER
MANAGEMENT SCHEMATICS

Many schematics for power management provided by Analog
Devices have enhancements that improve the simulation
experience. The main purpose of these enhancements is so that
the data sheet limits may be simulated with easy to understand
pull-down menus.

One example is an additional dialog box associated with the
parameters of switching regulators so that everything important
for simulation of the IC and the IC limits is easily accessible.
The Edit Device Parameters dialog box is accessed when a user
double-clicks on the schematic component, or right-clicks and
selects Edit Part (see Figure 26).

o+ Edit Device Parameters
Redson H 445m o PRdson L 208.8m =
K ADFZIT0 = | UVLO Threshold (Resing) (3.19
SW Current Limit 12 +| Tminon o3
Osallator Tolerance (%) |0 = | Enable Threshold 12 z
Fused o Adjustable Output [AD) -
Ok Cancel
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Figure 26. Edit Device Parameters: Switching Regulators

Another example is an additional dialog box associated with the
parameters of the output capacitance (Cour). Often the
optimum output capacitance cannot be achieved by a single,
real-world capacitor. Instead, it is achieved by more than one
capacitor in parallel. Although the buck schematic may only
show the symbol for a single capacitor, the real-world design
may call for more than one placed in parallel (see Figure 27).

» Edit Device Parameters @
. i @
Effective Capacitance 7.461 =
Equiv. Series Resistance 2m g
- @
Quantity (in parallel) 1 =
Initial Condition -4 =

| Use Initial Condition

Ok l | Cancel
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Figure 27. Edit Device Parameters: Capacitor

The Edit Device Parameters dialog box for this capacitor
specifies how many capacitors are in parallel, their effective
capacitance, and their effective series resistance. This information is
critical for simulation and is important for the design engineer
to know.

The inductor is another component that has been enhanced
(see Figure 28).

» Edit Device Parameters @
Effective Inductance 12u g
) |
DC Resistance 65.7m =
- - (]
Initial Condition 0 =
v | Use Initial Condition
0ok l ‘ Cancel 5

Figure 28. Edit Device Parameters: Inductors
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ADIsimPE LIMITATIONS

ADIsimPE supports Analog Devices encrypted content as well
as additional circuits. The additional circuits are bound by the
limits of the SIMetrix/SIMPLIS Intro version:

e 120 internal analog nodes
e 36 digital nodes

e 72 digital ports

e 24 digital components

e 36 digital outputs

The internal analog node limit does not apply to the encrypted
content. However, the node limit does apply to nodes from a
larger application circuit of the customer including nodes inside
elements, such as nonencrypted op amps. In practice, the Analog
Devices application schematics already include the minimum
necessary external components to define and to simulate the
circuit. In addition, when an encrypted model is placed into a
schematic, its internal representation does not count against the
limits.

ADIsimPE cannot simulate encrypted schematics from other
companies.

Legal Terms and Conditions

ADIsimPE has no limits on the size of the schematics that can
be drawn. The only limits apply to what can be simulated. These
limits include the following:

e A maximum of 15 additional state variables. A capacitor or
an inductor each requires one state variable. Each time
varying or small signal ac sources require one state
variable, with the exception of sinusoidal or cosinusoidal
sources, which require two state variables per source.

e A maximum of 10 additional capacitors or inductors
combined.

e A maximum of six additional switches, simple or transistor.

e A maximum of six additional logic gates.

e A maximum of 26 states. Each piece wise linear (PWL)
element requires one state. Each switch requires one state.
Each time varying source requires one state. Each logic
gate requires one state.

e A maximum of 100 new topologies because 100 topologies
are enough for simple switching circuits that use only
simple models. More complex circuits or circuits that have
more complicated models may exceed this limit. Encrypted
models that typically require multiple topologies can
greatly expand this limitation.

The limits are not applicable to the full licensed version of
SIMetrix/SIMPLIS.

Information furnished by Analog Devices is believed to be accurate and reliable. However, no responsibility is assumed by Analog Devices for its use, nor for any infringements of patents or
other rights of third parties that may result from its use. No license is granted by implication or otherwise under any patent or patent rights of Analog Devices. Trademarks and registered
trademarks are the property of their respective owners. Information contained within this document is subject to change without notice. Software or hardware provided by Analog Devices
may not be disassembled, decompiled or reverse engineered. Analog Devices’ standard terms and conditions for products purchased from Analog Devices can be found at:

http://www.analog.com/en/content/analog_devices_terms_and_conditions/fca.html.

©2014-2016 Analog Devices, Inc. All rights reserved. Trademarks and
registered trademarks are the property of their respective owners.
UG12382-0-8/16(A)
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